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Safety Notices

CAUTION

A CAUTION notice denotes a hazard. It 
calls attention to an operating 
procedure, practice, or the like that, if 
not correctly performed or adhered to, 
could result in damage to the product 
or loss of important data. Do not 
proceed beyond a CAUTION notice 
until the indicated conditions are fully 
understood and met. 

WARNING

A WARNING notice denotes a hazard. 
It calls attention to an operating 
procedure, practice, or the like that, if 
not correctly performed or adhered to, 
could result in personal injury or 
death. Do not proceed beyond a 
WARNING notice until the indicated 
conditions are fully understood and 
met.
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Where to Find the Latest Information

Documentation is updated periodically. For the latest information about these products, including instrument software 
upgrades, application information, and product information, see the following URLs:

http://www.keysight.com/find/pxa

http://www.keysight.com/find/mxa

http://www.keysight.com/find/exa

http://www.keysight.com/find/cxa

To receive the latest updates by email, subscribe to Keysight Email Updates:

http://www.keysight.com/find/emailupdates

Information on preventing instrument damage can be found at:

http://www.keysight.com/find/PreventingInstrumentRepair

Is your product software up-to-date?

Periodically, Keysight releases software updates to fix known defects and incorporate product enhancements. To search for 
software updates for your product, go to the Keysight Technical Support website at:

http://www.keysight.com/find/techsupport

http://www.keysight.com/find/pxa
http://www.keysight.com/find/mxa
http://www.keysight.com/find/exa
http://www.keysight.com/find/cxa
http://www.keysight.com/find/emailupdates


4 



Security Features and Document of Volatility

Contents

Table of Contents

1 Contacting Keysight Sales and Service Offices

2 Products Covered by this Document

X-Series Processor and Disk Drive Configurations 10

Processor Assembly Configuration 10

Disk Drive Configuration 10

Determining Instrument Configuration based on Product Name 12

Processor Assembly Configuration 12

Disk Drive Configuration 13

Rear Panel Configurations 14

Determining Installed Options 15

3 Security Terms and Definitions

4 Instrument Memory & Volatility

Non-Volatile Memory 20

Disk Drive Partitioning 26

Volatile Memory 27

5 Memory Clearing, Sanitization and Removal Procedures

Instrument Sanitization Procedures 31

Application License Key Storage 31

Regenerating a Site Key License for 89601A VSA Application 31

Replacement of Processor Assembly 31

Replacement of Disk Drive 33

Archiving and Restoring Factory Calibration Data Files 35

Tools Required 35

Determining Instrument Software Revision 36

Software Revision A.01.55 or Lower 37

Data Backup using XML File 37

Data Restore using XML File 37

Software Revision Greater than A.01.55 and Lower than A.02.00 37

Data Backup using Utility Program 38

Data Restore using Utility Program 38

Software Revision A.02.00 or Greater 39

Data Backup or Restore using Alignment Data Wizard 39

6 Processor Assembly Removal Procedure

7 Disk Drive Removal Procedure
 5



Contents
Instruments with Non-Removable Drives 44

Instruments with Removable Drives 45

8 User and Remote Interface Security Measures

SCPI/GPIB Control of Interfaces 47

Operating System Security Features 47

Determining the Instrument’s Operating System 48

USB Interfaces 48

Disabling or Enabling AutoRun/AutoPlay 48

Windows 7 48

Windows XP 48

Configuring USB for Read-only 51

9 Procedure for Declassifying a Faulty Instrument

10 Special Options

Option SF1 56

Support 56

Menu & Command Changes 56

File Menu 56

System Menu 56

SCPI Commands 56

Right-Click (Popup) Menu 56

Option SF2 57

Support 57

Operating System Changes 57

Menu & Command Changes 58

Front-panel Keys 58

File Menu 58

System Menu 58

SCPI Commands 58

Right-Click (Popup) Menu 61

Appendix A References
6 



7

Security Features and Document of Volatility
Contacting Keysight Sales and Service Offices

1 Contacting Keysight Sales and Service Offices

Assistance with test and measurement needs, and information to help you find a local Keysight office, is available via the 
internet at, http://www.keysight.com/find/assist. If you do not have internet access, please contact your designated 
Keysight representative.

NOTE In any correspondence or telephone conversation, refer to the instrument by its model number 
and full serial number. With this information, the Keysight representative can determine whether 
your unit is still within its warranty period.

http://www.keysight.com/find/assist
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2 Products Covered by this Document

This document describes instrument memory types and security features. It provides a statement regarding the volatility 
of all memory types, and specifies the steps required to declassify an instrument through memory clearing, sanitization, or 
removal. 

For additional information, go to:

http://www.keysight.com/find/security

IMPORTANT Be sure that all information stored by the user in the instrument that needs to be saved is 
properly backed up before attempting to clear any of the instrument memory. Keysight 
Technologies cannot be held responsible for any lost files or data resulting from the clearing of 
memory. 

Be sure to read this document entirely before proceeding with any file deletion or memory 
clearing.

Product Family Name Product Names Model Numbers

X-Series Signal Analyzers PXA Signal Analyzer N9030A-503, -508, -513, -526, -543, -544, -550

MXA Signal Analyzer N9020A-503, -508, -513, -526

EXA Signal Analyzer N9010A-503, -507, -513, -526, -532, -544

CXA Signal Analyzer N9000A-503, -507, 513, -526
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Products Covered by this Document
X-Series Processor and Disk Drive Configurations

X-Series Processor and Disk Drive Configurations

This document describes alternative Processor and Disk Drive Configurations for X-Series analyzers. Due to continuous 
improvement of the X Series Analyzer range, configurations may vary according to such factors as: manufacturing date, 
product name, and installed options. Processor and disk drive configurations are considered separately, due to the large 
number of possible combinations.

Processor Assembly Configuration

There are three possible processor assembly configurations: a single-core microprocessor with non-removable (fixed) disk 
drive, a single-core microprocessor with removable disk drive, or a dual-core processor with removable disk drive. The 
relationship between processor assembly type and product name is detailed in Table 2-1 below. (For details of how to 
determine installed options, see “Determining Installed Options” on page 15)

Disk Drive Configuration

There are several possible disk drive configurations, as listed below in Table 2-2. The actual configuration depends on the 
instrument’s Product Name and installed options (Options SSD, PC2, PC3, PC4 or PC5). For details of how to determine 
installed options, see “Determining Installed Options” on page 15.

Table 2-1 Processor Assembly & Product Name

Type Configuration Product Names & Installed Options

1 Single-Core, Fixed Disk The disk is referred to as "fixed", because it can only be removed by removing and opening the 
instrument’s processor assembly. 

This configuration is standard for:

a. MXA instruments without Option PC2 or PC4,

b. EXA instruments without Option PC2, PC3, PC4 or PC5,

c. CXA instruments without Option PC3 or PC5.

2 Single-Core, Removable Disk The disk may be removed from the instrument’s rear panel, without removing or opening the 
processor assembly.

This configuration is standard for:

a. EXA instruments with Option PC3 or PC5,

b. CXA instruments with Option PC3 or PC5.

3 Dual-Core, Removable Disk The disk may be removed from the instrument’s rear panel, without removing or opening the 
processor assembly.

The Dual-Core processor unit is standard for:

a. all PXA instruments, 

b. MXA instruments with Option PC2 or PC4,

c. EXA instruments with Option PC2 or PC4.
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For details of the capacities of each of the drive types listed below, see “Non-Volatile Memory” on page 20.

Option SSD

You can obtain a Removable Solid-State disk drive for your instrument, either as an upgrade to replace a Removable 
Magnetic disk drive, or as an additional solid-state drive, by ordering Option SSD. You can order Option SSD either at the 
time that you purchase the instrument, or at any later time. 

If your instrument’s current processor assembly configuration is Single-Core, Fixed Disk, in order to be able to use the 
removable disk you will need to upgrade the instrument to a Dual-Core, Removable Disk or Single-Core, Removable Disk 
processor assembly, by ordering Option PC4 or PC5 respectively. (Older CXA instruments may require Option PC3 instead 
of PC5. Before ordering, check with your Keysight Sales office, as described in “Contacting Keysight Sales and Service 
Offices” on page 7.)

Note that Removable Solid-State disk units exist in two capacities. Earlier disks had a total capacity of 32 GB, while 
newer units have a total capacity of 80 GB.

Table 2-2 Disk Drive Configurations

Type Configuration Product Names & Installed Options

Fixed Magnetic Fixed Magnetic Drive This configuration applies to:

a. MXA instruments without Option PC2 or PC4,

b. EXA instruments without Option PC2, PC3, PC4 or PC5,

c. CXA instruments without Option PC3 or PC5.

Removable 
Magnetic

Standard Removable Magnetic Drive This configuration applies to:

a. PXA instruments without Option SSD,

b. MXA instruments with Option PC2, but without Option SSD. 

c. EXA instruments with Option PC2 or PC3, but without Option SSD.

(To determine whether your instrument includes Option SSD, which is now included 
with new instruments by default, see “Determining Installed Options” on page 15.)

Removable 
Solid-State

Removable Solid-State Drive

(Flash drive)

This configuration applies to all instruments with Option SSD, Option PC4 or Option 
PC5.

Originally an option, a solid-state disk drive cartridge is now supplied by default with 
X-Series Analyzers.
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Determining Instrument Configuration based on Product Name

Use the following procedures to determine the processor assembly and disk drive configurations of your instrument, 
starting from its Product Name.

Processor Assembly Configuration

The following procedure allows you to determine whether your instrument has a Single-Core, Fixed Disk, Single-Core, 
Removable Disk or Dual-Core, Removable Disk processor assembly.

Step Procedure

1 What is the Product Name of your instrument?

PXA: Go to Step 8.

MXA: Go to Step 2.

EXA: Go to Step 3.

CXA: Go to Step 5.

2 Examine the instrument’s rear panel and compare with the illustrations in “Rear Panel Configurations” on page 14. Does it resemble or 
Figure 2-1 (Fixed Disk) or Figure 2-2 (Removable Disk)?

Fixed Disk: Go to Step 6.

Removable Disk: Go to Step 8.

3 Examine the instrument’s rear panel and compare with the illustrations in “Rear Panel Configurations” on page 14. Does it resemble or 
Figure 2-1 (Fixed Disk) or Figure 2-2 (Removable Disk)?

Fixed Disk: Go to Step 6.

Removable Disk: Go to Step 4.

4 Are Options PC2, PC3, PC4 or PC5 installed? 

(To determine whether any of these options are installed, see “Determining Installed Options” on page 15 below.)

PC2 or PC4 installed: Go to Step 8.

PC3 or PC5 installed: Go to Step 7.

5 Examine the instrument’s rear panel and compare with the illustrations in “Rear Panel Configurations” on page 14. Does it resemble or 
Figure 2-1 (Fixed Disk) or Figure 2-2 (Removable Disk)?

Fixed Disk: Go to Step 6.

Removable Disk: Go to Step 7.

6 Your instrument has a Single-Core, Fixed Disk processor assembly.

7 Your instrument has a Single-Core, Removable Disk processor assembly.

8 Your instrument has a Dual-Core, Removable Disk processor assembly.
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Disk Drive Configuration

The following procedure allows you to determine your instrument’s disk drive configuration

Step Procedure

1 What is the Product Name of your instrument?

PXA: Go to Step 5.

MXA: Go to Step 3.

EXA: Go to Step 3.

CXA: Go to Step 2.

2 Examine the instrument’s rear panel and compare with the illustrations in “Rear Panel Configurations” on page 14. Does it resemble or 
Figure 2-1 (Fixed Disk) or Figure 2-2 (Removable Disk)?

Fixed Disk: Go to Step 4.

Removable Disk: Go to Step 6.

3 Examine the instrument’s rear panel and compare with the illustrations in “Rear Panel Configurations” on page 14. Does it resemble or 
Figure 2-1 (Fixed Disk) or Figure 2-2 (Removable Disk)?

Fixed Disk: Go to Step 4.

Removable Disk: Go to Step 5.

4 Your instrument has a 40 GB Fixed Magnetic disk drive.

5 Check the instrument’s installed options (see “Determining Installed Options” on page 15).

If the list includes "N90X0A-IDE", your instrument has a 160 GB Removable Magnetic disk drive.

If the list includes "N90X0A-SSD", your instrument has a 32 GB or 80 GB Removable Solid-State disk drive.

6 Your instrument has a 32 GB or 80 GB Removable Solid-State disk drive.
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Rear Panel Configurations

Figure 2-1 Rear Panel of Instrument with Fixed Magnetic Disk

Figure 2-2 Rear Panel of Instrument with Removable Magnetic or Removable Solid-State Disk
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Determining Installed Options

Use the following procedure to determine whether your instrument has a magnetic or solid-state disk drive, and whether 
Options PC2/PC4 (Dual-Core Processor), or PC3/PC5 (Single-Core Processor) are installed.

1. Using the instrument front panel and softkey menus, press System > Show > System.

2. The "Show System" display appears. Look for start of the "Option" listing, a few lines below the top of the table, as 
shown in Figure 2-3 below.

Figure 2-3 Show System Display: Option Listing

3. If the Option list includes "N90X0A-SSD" (where "X" is a digit between 0 and 3, according to the Model Number), then 
a Removable Solid-State disk drive is installed (either because the instrument was supplied with this drive, or 
because Option SSD has been installed).

If your instrument has a Fixed Magnetic or Removable Magnetic disk drive, then "N90X0A-IDE" is listed, as shown in 
Figure 2-3 above.

4. If the Option list includes "N90X0A-PC2" (where "X" is a digit between 1 and 3, according to the Model Number), then 
Option PC2 is installed.

5. If the Option list includes "N90X0A-PC3" (where "X" is a digit between 0 and 1, according to the Model Number), then 
Option PC3 is installed.

6. If the Option list includes "N90X0A-PC4" (where "X" is a digit between 1 and 3, according to the Model Number), then 
Option PC4 is installed.

7. If the Option list includes "N90X0A-PC5" (where "X" is a digit between 0 and 1, according to the Model Number), then 
Option PC5 is installed.

To dismiss the "Show System" display, press any other front-panel or menu key.
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3 Security Terms and Definitions

Term Definition

Clearing As defined in Section 8-301a of DoD 5220.22-M, “National Industrial Security Program Operating Manual (NISPOM)”, 
clearing is the process of eradicating the data on media before reusing the media in an environment that provides an 
acceptable level of protection for the data that was on the media before clearing. Hence, clearing is typically used when 
the instrument is to remain in an environment with an acceptable level of protection.

Instrument 
Declassification

A term that refers to procedures that must be undertaken before an instrument can be removed from a secure 
environment, such as is the case when the instrument is returned for calibration. Declassification procedures include 
memory sanitization or memory removal, or both. Keysight declassification procedures are designed to meet the 
requirements specified in DoD 5220.22-M, “National Industrial Security Program Operating Manual (NISPOM)”, Chapter 8.

Sanitization As defined in Section 8-301b of DoD 5220.22-M, “National Industrial Security Program Operating Manual (NISPOM)”, 
sanitization is the process of removing the data from media before reusing the media in an environment that does not 
provide an acceptable level of protection for the data that was in the media before sanitizing. Hence, instrument 
sanitization is typically required when an instrument is moved from a secure to a non-secure environment, such as when it 
is returned to the factory for calibration.

Keysight memory sanitization procedures are designed for customers who need to meet the requirements specified by the 
US Defense Security Service (DSS). These requirements are specified in the “Clearing and Sanitization Matrix” in 
Section 5.2.5.5.5 of the ISFO Process Manual for the Certification and Accreditation of Classified Systems under the 
NISPOM.

Secure Erase Secure Erase is a term that is used to refer to either the clearing or sanitization features of Keysight instruments.
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4 Instrument Memory & Volatility

This chapter summarizes all memory types in the instrument, for the following processor assembly and disk drive 
configurations:

a. Single-Core, Fixed Disk processor assemblies,

b. Single-Core, Removable Disk and Dual-Core, Removable Disk processor assemblies.

For definition of terms, and to determine the configuration of your instrument, based on its Product Name and installed 
options, see “X-Series Processor and Disk Drive Configurations” on page 10.

The descriptions below are divided between:

1. Non-Volatile Memory,

2. Volatile Memory.
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Non-Volatile Memory

Non-Volatile Memory

This section contains information on the memory components available in your instrument. 

• Table 4-1 on page 20 describes memory components that are present in all instruments. 

• Table 4-2 on page 24 describes additional memory components that are present only in PXA and some MXA 
instruments.

Both tables provide details of the size of each memory component, its type, how it is used, its location, volatility, and the 
sanitization procedure.

NOTE The instrument contains no user-accessible non-volatile memory, except for the Disk Drive 
described in Item 1 of Table 4-1. For this reason, as indicated in the tables below, no sanitization 
procedure is required for any memory component except the Disk Drive.

Table 4-1 Summary of Non-Volatile instrument memory - All Instruments (Single-Core and Dual-Core Processors)

Memory Component, 
Type and Size
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Purpose/Contents Data Input Method Location in 
Instrument and 
Remarks

Sanitization 
Procedure

1. Disk Drive

Fixed Magnetic: 
40 GByte

Removable Magnetic: 
160 GByte

Removable 
Solid-State Original: 
32 GByte

New: 80 GByte

This drive is 
partitioned, as 
detailed in “Disk 
Drive Partitioning” on 
page 26.

Yes Yes Contains operating system, 
Instrument Software, Factory 
Calibration Data, Diagnostic 
software, Crash recovery 
image, user instrument states, 
user data files, user trace data 
and any user installed third 
party software.

Programmed before 
installation or by 
factory/service center 
calibration procedure 
software, or by upgrade 
installation software. 
Also programmed via 
operations and by the 
user.

Single-Core, Fixed 
Disk: A4 Processor 
Assy.

Single-Core, 
Removable Disk and 
Dual-Core, 
Removable Disk: 
Rear Panel 
(Removable)

Contains user data.

See Table 5-1 on 
page 29.

2. CPU BIOS 

(CMOS NVRAM)

256 Byte

(battery backed)

No Yes Contains default BIOS settings 
to use when booting the 
Processor Assembly.

Programmed by factory. 
Settings can be toggled 
by user.

A4 Processor Assy.

Battery backed to 
maintain Windows 
calendar time.

Contains no user 
data.

None.

3. License Storage 
Memory

(EEPROM)

512 kbit

No Yes Contains instrument serial 
number and license keys for 
measurement applications. 
License keys are encrypted. 

Programmed before 
installation and by 
installing new license 
keys.

A7 Midplane Assy.

Contains no user 
data.

None.
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4. Config & Cal 
Memory 

(EEPROM)

8 kbit

(1024 x 8)

No Yes Header EEPROM used to 
identify the assembly.

Programmed before 
installation.

A14 Synthesizer 
Assy.

Contains no user 
data.

None.

5. Config Memory 

(EEPROM)

8 kbit

(1024 x 8)

No Yes Contains measurement and 
control software, which is 
preloaded into FPGA during 
instrument power-up.

Programmed before 
installation.

A14 Synthesizer 
Assy.

Contains no user 
data.

None.

6. Config & Cal 
Memory 

(EEPROM)

8 kbit

(1024 x 8)

No Yes Header EEPROM used to 
identify the assembly.

Programmed before 
installation.

A15 Front End 
Control Assy.

Contains no user 
data.

None.

7. Config Memory 

(Flash)

2 Mbit

No Yes Contains measurement and 
control software, which is 
preloaded into FPGA during 
instrument power-up. Primarily 
YTF, attenuator, and front end 
switch control.

Programmed before 
installation.

A15 Front End 
Control Assy.

Contains no user 
data.

None.

8. Config & Cal 
Memory 

(EEPROM)

8 kbit

(1024 x 8)

No Yes Header EEPROM used to 
identify the assembly.

Programmed before 
installation.

A2 Analog IF Assy.

Contains no user 
data.

None.

9. Control Logic 
Memory

(CPLD)

1600 Gates

No Yes Contains control algorithms to 
optimize filter performance.

Programmed before 
installation.

A2 Analog IF Assy.

Contains no user 
data.

None.

10. Config & Cal 
Memory 

(EEPROM)

8 kbit

(1024 x 8)

No Yes Header EEPROM used to 
identify the assembly.

Programmed before 
installation.

A3 Digital IF Assy.

Contains no user 
data.

None.

Table 4-1 Summary of Non-Volatile instrument memory - All Instruments (Single-Core and Dual-Core Processors)
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11. Config Memory 

(Flash)

8 Mbit

No Yes Contains measurement and 
control software, which is 
preloaded into FPGA during 
instrument power-up.

Programmed before 
installation.

A3 Digital IF Assy.

Contains no user 
data.

None.

12. Control Logic 
Memory 

(CPLD)

6400 Gates

No Yes Contains measurement and 
control algorithms to optimize 
digital fil tering.

Programmed before 
installation.

A3 Digital IF Assy.

Contains no user 
data.

None.

13. Serial Presence 
Detect Memory

(EEPROM)

2 Mbit

No Yes Used on commercial SDRAM 
Module, programmed by chip 
vendor. Contains module 
identification information. 

Programmed by IC 
vendor only.

A3 Digital IF Assy.

Contains no user 
data.

None.

14. Config & Cal 
Memory 

(EEPROM)

8 kbit

(1024 x 8)

No Yes Header EEPROM used to 
identify the assembly.

Programmed before 
installation.

A16 Reference Assy.

Contains no user 
data.

None.

15. FPGA Config 
Memory

(EEPROM)

2 Mbit

No Yes Contains measurement and 
control software.

Programmed before 
installation.

A16 Reference Assy.

Contains no user 
data.

None.

16. Digital 
Potentiometer

 (EEPROM)

112 bits

(14 Bytes) 

No Yes Contains default data to preset 
digital potentiometers during 
power-up. 

Programmed before 
installation.

A16 Reference Assy.

Contains no user 
data.

None.

17. Front Panel 
EEPROM

64 kbit

No Yes Contains software for running 
front panel microcontroller. 
Operates front panel LEDs, and 
transmits key presses to 
processor.

Programmed before 
installation.

A1A2 Front Panel 
Interface Board

Contains no user 
data.

None.

18. Front Panel CPLD

800 Gates

No Yes Contains fixed digital logic 
associated with front panel 
keyboard button operation and 
LEDs.

Programmed before 
installation at the 
factory only.

A1A2 Front Panel 
Interface Board

Contains no user 
data.

None.

Table 4-1 Summary of Non-Volatile instrument memory - All Instruments (Single-Core and Dual-Core Processors)
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19. EDID Memory

(EEPROM)

2 kbit

No Yes Extended Display Identification 
Data is a VESA standard data 
format that contains basic 
information about a monitor 
and its capabilities, including 
vendor information, maximum 
image size, color 
characteristics, factory pre-set 
timings, frequency range 
limits, and character strings for 
the monitor name and serial 
number.

Programmed before 
installation.

A1A2 Front Panel 
Interface Board.

Contains no user 
data.

None.

20. A11 Config 
Memory

(EEPROM)

8 kbit

No Yes Header EEPROM used to 
identify the assembly.

Programmed before 
installation.

A11 Low Band 
Switch.

Contains no user 
data.

None.

21. A12 Config 
Memory

(EEPROM)

8 kbit

No Yes Header EEPROM used to 
identify the assembly.

Programmed before 
installation.

A12 YTF Assembly.

Contains no user 
data.

None.

22. A13 Config 
Memory

(EEPROM)

8 kbit

No Yes Header EEPROM used to 
identify the assembly.

Programmed before 
installation.

A13 Front End 
Assembly.

Contains no user 
data.

None.

23. A18 Header 
Memory.

(EEPROM)

8 kbit

No Yes Contains header information 
used to identify the assembly.

Programmed before 
installation.

A18 BBIQ 
Connector 
Assembly.

Contains no user 
data.

None.

24. A19 Header 
Memory.

(EEPROM)

8 kbit

No Yes Contains header information 
used to identify the assembly.

Programmed before 
installation.

A19 BBIQ Main 
Assembly.

Contains no user 
data.

None.

25. Config Memory

(Flash)

2 Mbit

No Yes Contains measurement and 
control software, which is 
preloaded into FPGA during 
instrument power-up.

Programmed before 
installation.

A19 BBIQ Main 
Assembly.

Contains no user 
data.

None.

26. Config Memory

(Flash)

32 Mbit

No Yes Contains measurement and 
control software, which is 
preloaded into FPGA during 
instrument power-up.

Programmed before 
installation.

A19 BBIQ Main 
Assembly.

Contains no user 
data.

None.

Table 4-1 Summary of Non-Volatile instrument memory - All Instruments (Single-Core and Dual-Core Processors)
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The memory components listed in Table 4-2 below are present in:

• all PXA instruments,

• all MXA instruments with serial numbers higher than or equal to MY/SG/US5233,

• MXA instruments with serial numbers lower than MY/SG/US5233, but with Options B85, B1A or B1X.

Table 4-2 Summary of Non-Volatile instrument memory - Additional Components for all PXA Instruments and some MXA 
Instruments

Memory Component, 
Type and Size
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1. Boot ROM

(Flash)

8 MByte

No Yes Contains the boot ROM, 
operating system and run-time 
code for the WBDIF CPU.

Programmed by factory 
at installation time, or 
during firmware 
upgrade.

A26 WBDIF 

assemblya

Contains no user 
data.

None.

2. (Flash) 

16 MByte

(2 x 64 Mbit)

No Yes Contains up to 3 WBDIF FPGA 
images.

Programmed by factory 
at installation time, or 
during FPGA upgrade 
process.

A26 WBDIF 

assemblya

Contains no user 
data.

None.

3. (EEPROM) 

512 Byte

No Yes Contains header information 
used to identify the assembly, 
and configuration information 
used to initialize the PCI bus.

Programmed before 
installation.

A26 WBDIF 

assemblya

Contains no user 
data.

None.

4. (EEPROM)

1024 byte 

No Yes Contains configuration 
information used during 
initialization of the PCI bus. 

This component is currently 
unprogrammed.

Programmed before 
installation.

A26 WBDIF 

assemblya

Contains no user 
data.

None.

5. (CPLD)

256 Macrocells

No Yes Contains critical hardware 
control algorithms.

Programmed before 
installation.

A26 WBDIF 

assemblya

Contains no user 
data.

None.

6. A16A1 Header 
Memory

(EEPROM)

8 kbit

No Yes Contains header information 
used to identify the assembly.

Programmed before 
installation.

A16A1 Reference 
Daughter 

Assemblyb

Contains no user 
data.

None.

7. Config Memory

(Flash)

1 Mbit

No Yes Contains measurement and 
control software, which is 
preloaded into FPGA during 
instrument power-up.

Programmed before 
installation.

A16A1 Reference 
Daughter 

Assemblyb

Contains no user 
data.

None.
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8. A25 Header 
Memory

(EEPROM)

8 kbit

No Yes Contains header information 
used to identify the assembly.

Programmed before 
installation.

A25 WBAIFa

Contains no user 
data.

None.

9. Control Logic 
Memory

(CPLD)

1600 Gates

No Yes Contains control algorithms. Programmed before 
installation.

A25 WBAIFa

Contains no user 
data.

None.

10. Config Memory

(Flash)

2 Mbit

No Yes Contains measurement and 
control software, which is 
preloaded into FPGA during 
instrument power-up.

Programmed before 
installation.

A25 WBAIFa

Contains no user 
data.

None.

a. Present in all PXA instruments, and MXA instruments with Options B85, B1A or B1X.
b. Present in all PXA instruments, all MXA instruments with serial numbers higher than or equal to 

MY/SG/US5233, and MXA instruments with serial numbers lower than MY/SG/US5233, but with Options 
B85, B1A or B1X.

Table 4-2 Summary of Non-Volatile instrument memory - Additional Components for all PXA Instruments and some MXA 
Instruments

Memory Component, 
Type and Size
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Disk Drive Partitioning

The instrument’s disk drive is divided at the factory into three visible partitions, labeled C:, D: and E:, plus a fourth hidden 
partition. 

The sizes of each partition vary according to the instrument’s Disk Drive Configuration.

Details of the sizes and functions of all partitions are provided in Table 4-3 below.

Table 4-3 Disk Drive Partitions

Partition Label Size (GBytes) Purpose

C: Fixed Magnetic: 15 GB

Removable Magnetic: 62 GB

Removable Solid-State:

(Original) 16 GB

(New) 32 GB

Primary partition for applications and secondary data.

D: Fixed Magnetic: 6 GB

Removable Magnetic: 23 GB

Removable Solid-State:

(Original) 3.75 GB

(New) 17 GB

Default location for user data.

E: Fixed Magnetic: 6 GB

Removable Magnetic: 2.3 GB

Removable Solid-State:

(Original) 1.6 GB

(New) 2 GB

Calibration data.

Hidden Fixed Magnetic: 6.5 GB

Removable Magnetic: 54 GB

Removable Solid-State:

(Original) 8.2 GB

(New) 23 GB

Factory recovery image of the C: partition.
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Volatile Memory

The volatile memory in the instrument does not have battery backup. It does not retain any information when AC power is 
removed. 

Removing power from this memory meets the memory sanitization requirements specified in the “Clearing and 
Sanitization Matrix” in Section 5.2.5.5.5 of the ISFO Process Manual for the Certification and Accreditation of Classified 
Systems under the NISPOM.

Table 4-4 Summary of Volatile Instrument Memory - Instruments with Single-Core and Dual-Core Processors

Memory Type and 
Size
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1. Processor SDRAM

Single-Core, Fixed 
Disk: 1 GByte or 
2 GByte

Single-Core, 
Removable Disk: 
4 GByte

Dual-Core, 
Removable Disk: 
4 GByte or 8 GByte

Yes No Main dynamic RAM memory 
for processor. 

Contains working copies of 
operating system, 
instrument measurement 
applications, calibration 
data, and measurement 
data.

Programmed before 
installation, or by 
factory/service center 
calibration procedure 
software, or by firmware 
upgrade installation 
software.

Also programmed via 
firmware operations and 
by user.

A4 Processor Assy.

Contains user data.

Turn off 
instrument 

power.a

a. This memory is not battery backed-up or connected to standby power.

2. SDRAM

256 MByte

Yes No Contains measurement data 
from data acquisition 
system.

Programmed by 
firmware. Not accessible 
by user.

A3 Digital IF Assy.

Contains raw 
measurement data.

Turn off 
instrument 

power.a

3. SDRAM

2 GByte

Yes No Contains measurement data 
from data acquisition 
system.

Programmed by 
firmware. Not accessible 
by user.

A3 Digital IF Assy. 

For all N9030A 
instruments, and 
instruments with 
Options DP2, B40, 
MPB

Contains raw 
measurement data.

Turn off 
instrument 

power.a

4. SDRAM

2 GByte Module + 
256 MByte Module

Yes No Contains measurement data 
from data acquisition 
system.

Programmed by 
firmware. Not accessible 
by user.

A26 Wideband 
Digital IF Assy.

Contains raw 
measurement data.

Turn off 
instrument 

power.a
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5 Memory Clearing, Sanitization and Removal 
Procedures

This section explains how to clear, sanitize, and remove memory from your instrument, for all types of non-volatile 
memory that can be written to during normal instrument operation.

Table 5-1 Disk Drive

Description and purpose The Disk Drive is the main memory for the instrument. It has very large storage capacity, plus fast read and write 
times. There are no limitations on the number of read/write cycles.

It contains the operating system, Instrument Software, Factory Calibration Data, Diagnostic software, Crash recovery 
image, user instrument states, user data files, user trace data and any user-installed third party software. The Disk 
Drive is written to frequently by the operating system and other application software.

Size Fixed Magnetic magnetic disk drive: 40 Gigabytes

Removable Magnetic disk drive: 160 Gigabytes

Removable Solid-State disk drive: 32 Gigabytes (original) or 80 Gigabytes (new)

Memory clearing Software utilities are available that comply with the clearing requirements specified for Magnetic Disks and Flash 
Drives in the “Clearing and Sanitization Matrix” in Section 5.2.5.5.5 of the ISFO Process Manual for the Certification 
and Accreditation of Classified Systems under the NISPOM.

Memory sanitization We recommend always removing the Disk Drive to achieve sanitization. 

For program classifications lower than Top Secret, the disk can be sanitized using method "d" (for magnetic disks) or 
method "c" followed by "h" (for solid-state drives) as defined in the "Clearing and Sanitization Matrix" in 
Section 5.2.5.5.5 of the ISFO Process Manual for the Certification and Accreditation of Classified Systems under the 
NISPOM“. 

For Top Secret and higher program classifications, Disk Drive removal is the only acceptable sanitization procedure. 

Memory removal Single-Core, Fixed Disk Processor assembly: see “Instruments with Non-Removable Drives” on page 44, in the 
Chapter "Disk Drive Removal Procedure".

Single-Core, Removable Disk or Dual-Core, Removable Disk Processor assemblies: see “Instruments with Removable 
Drives” on page 45, in the Chapter "Disk Drive Removal Procedure".

Write protecting The Disk Drive cannot be write protected. The operating system and software must be able to read from and write to 
the drive during normal operation.

Memory validation The Disk Drive memory can be validated using third-party Windows utilities.

Table 5-2 CPLD, CMOS Programmable Logic Devices

Description and purpose These memory devices are used to execute timing, control, and measurement functions. No user data is contained in 
these devices. This memory cannot be written to during instrument operation.

Size 1600 to 6400 logic gates.
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Memory clearing Not applicable. This memory does not contain user information and is not accessible by the user.

Memory sanitization Not applicable. This memory does not contain user information and is not accessible by the user.

Memory removal Not applicable. 

Write protecting Not applicable. 

Memory validation Not applicable. 

Remarks These devices are programmed in the factory via diagnostic connectors on the PCB assemblies. After instrument 
assembly, the diagnostic connectors are not physically accessible and not electrically connected. 

Table 5-3 EEPROM Memories

Description and purpose These memories are used to identify the assemblies (header info) and store option configuration data. Some are also 
used to hold factory software for FPGAs. The software is loaded when the instrument powers up. This memory cannot 
be written to during instrument operation.

Size 2 kbit to 8 Mbit

Memory clearing Not applicable. This memory does not contain user information and is not accessible by the user.

Memory sanitization Not applicable. This memory does not contain user information and is not accessible by the user.

Memory removal Not applicable. 

Write protecting Not applicable. 

Memory validation Not applicable. 

Remarks With one exception, as described below, these memories are only writable by factory/service center software, or 
upgrade installation software. These memories are internally connected to proprietary internal control data busses (as 
opposed to standard computer busses such as IDE, PCI, USB). They are not accessible by the operating system or by 
third-party software, or by the user, to protect the measurement accuracy and consistency of the instrument. They are 
rarely modified, to ensure no degradation of instrument performance. These memories contain no user data. Many of 
these memories have long write times, and limited write endurance, so they are not intended to be written to 
dynamically by software.

The sole exception applies to the EEPROM on the A7 Midplane Assembly. Inserting a USB memory device containing 
a valid license key file into the instrument causes the key file to be copied to both the C: drive and the EEPROM on the 
A7 Midplane Assembly. 

Table 5-2 CPLD, CMOS Programmable Logic Devices
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Instrument Sanitization Procedures

This section includes flowcharts that describe how to sanitize an instrument by physical removal and replacement of 
either the Processor Assembly or Disk Drive.

• For Single-Core, Fixed Disk instruments, see “Replacement of Processor Assembly” on page 31.

• For Single-Core, Removable Disk and Dual-Core, Removable Disk instruments, see “Replacement of Disk Drive” on 
page 33.

Application License Key Storage

Note that License keys for most Applications are stored in EEPROM on the A7 Midplane Assembly (as described in Item 3 
of Table 4-1 on page 20). Therefore, when replacing either the Processor Assembly or Disk Drive, you do not need to back 
up and restore the license keys.

The sole exception is the 89601A VSA Application, which uses a Site Key license. For information on how to regenerate a 
Site Key, see Regenerating a Site Key License for 89601A VSA Application below.

Regenerating a Site Key License for 89601A VSA Application

When a repair requires the replacement of a Processor Assembly or Disk Drive for an instrument that includes the 89601A 
VSA Application, you must request a new Site Key License, as if installing 89601A VSA for the first time. Details of how to 
do this are provided in the following article, available on the Keysight web site:

How do I recover my VSA 89600S license after a hard drive crash?

NOTE This requirement applies only to the 89601A VSA Application. It does not apply to the newer 
89601B.

Replacement of Processor Assembly

This procedure applies only to Single-Core, Fixed Disk instruments.

Refer to the flowchart in Figure 5-1 below for details of how to perform this procedure. 

Note that this flowchart differs from that for replacement of the Disk Drive only in that the entire Processor Assembly is 
replaced. The steps that differ between the two procedures are marked in yellow in the flowcharts.

For details of how to archive or restore the instrument’s calibration files (Steps 2, 11 and 15 in the flowchart), see 
“Archiving and Restoring Factory Calibration Data Files” on page 35.

For details of how to remove the Processor Assembly (Step 5), see “Processor Assembly Removal Procedure” on page 41.

http://www.keysight.com/find/recoverVSAlicense
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Figure 5-1 Flowchart for Instrument Sanitization Process by Processor Removal
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Replacement of Disk Drive

This procedure applies to Single-Core, Removable Disk and Dual-Core, Removable Disk instruments.

Refer to the flowchart in Figure 5-2 below for details of how to perform this procedure. 

Note that this flowchart differs from that for replacement of the Processor Assembly only in that the removable Disk Drive 
is replaced. The steps that differ between the two procedures are marked in yellow in the flowcharts.

For details of how to archive or restore the instrument’s calibration files (Steps 2, 11 and 15 in the flowchart), see 
“Archiving and Restoring Factory Calibration Data Files” on page 35.

For details of how to remove the Disk Drive (Step 5), see “Disk Drive Removal Procedure” on page 43.

IMPORTANT Ensure that the instrument software revision on the secondary non-classified disk drive matches 
that of the classified drive in the controlled area.

If the non–classified drive receives a software upgrade, or if the non-classified drive is replaced 
with a drive that contains a newer revision of software than that of the classified drive, the 
classified drive will require a software upgrade (inside the controlled area) to match the 
non-classified drive.
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Figure 5-2 Flowchart for Instrument Sanitization Process by Disk Drive Removal
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Archiving and Restoring Factory Calibration Data Files

This section describes how to archive ("back up") the instrument’s factory calibration data to an external USB memory 
device, or restore the calibration data from an external memory device.

The backup and restore procedures differ according to the instrument software revision. This section describes the three 
possible pairs of procedures.

To determine the instrument software revision, follow the procedure “Determining Instrument Software Revision” on 
page 36 below.

To determine which backup or restore procedures should be used, according to the instrument software revision, see 
Table 5-4 on page 37.

Tools Required

To perform backup or restore operations, you need:

• a mouse with a USB interface

• a portable memory device with a USB interface

• an alphanumeric keyboard with a USB interface
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Determining Instrument Software Revision

1. On the instrument front panel, press System > Show > System.

2. The "Show System" display appears, as shown in Figure 5-3 below. Look for the Software Revision number specified 
in the "Instrument S/W Revision" entry.

Figure 5-3 Show System Display

3. To dismiss the "Show System" display, press any other front-panel or menu key.



37

Memory Clearing, Sanitization and Removal Procedures
Archiving and Restoring Factory Calibration Data Files

When you have obtained the instrument Software Revision number, refer to Table 5-4 on page 37 below for the 
appropriate backup or restore procedure.

Software Revision A.01.55 or Lower

If the instrument software revision is A.01.55 or lower, the calibration data is stored in an XML database file. 

Data Backup using XML File
Follow the steps below:

1. Close the instrument application software by pressing File > Exit > Enter.

2. Plug the mouse’s USB cable into one of the instrument’s USB ports.

3. Plug the USB memory device into another of the instrument’s USB ports.

4. Using the mouse, double-click on the Windows Explorer icon on the desktop and navigate to the following folder: 

E:\AlignDataStorage

5. Copy the following file onto the USB memory device: 

CurrentDataSet.xml

Data Restore using XML File
The data can be restored from a USB memory device containing the XML database file, by using the following process.

1. Close the instrument application software by pressing File > Exit > Enter.

2. Plug the mouse’s USB cable into one of the instrument’s USB ports.

3. Plug the USB memory device into another of the instrument’s USB ports.

4. Using the mouse, double-click on the Windows Explorer icon on the desktop and navigate to a folder on the USB 
memory device containing a previously-saved calibration data file named:

CurrentDataSet.xml

5. Select the calibration data file, then copy it to the Windows clipboard by selecting Edit > Copy from the Windows 
Explorer pull-down menu.

6. Navigate to the folder below and paste the file by selecting Edit > Paste from the Windows Explorer pull-down menu: 

E:\AlignDataStorage

7. Verify that the file CurrentDataSet.xml was copied to the new location.

8. Cycle the instrument power.

Software Revision Greater than A.01.55 and Lower than A.02.00

If the instrument software revision is greater than A.01.55, the calibration data is stored in an SQL database file. 

Table 5-4 Backup & Restore Procedures for all Instrument Software Revisions

Instrument Software Revision Backup Procedure Restore Procedure

A.01.55 or lower See “Data Backup using XML File” on page 37. See “Data Restore using XML File” on page 37.

Greater than A.01.55; lower 
than A.02.00

See “Data Backup using Utility Program” on 
page 38.

See “Data Restore using Utility Program” on page 38.

A.02.00 or greater See “Data Backup or Restore using Alignment Data 
Wizard” on page 39.

See “Data Backup or Restore using Alignment Data Wizard” 
on page 39.
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For software revisions greater than A.01.55, but lower than A.02.00, the SQL file is written and read by a utility program 
called BackupAndRestore.exe.

Data Backup using Utility Program
Follow the steps below:

1. Close the instrument application software by pressing File > Exit > Enter.

2. Plug the mouse’s USB cable into one of the instrument’s USB ports.

3. Plug the USB memory device into another of the instrument’s USB ports.

4. Plug the USB keyboard into another of the instrument’s USB ports.

5. Using the mouse double-click on the Windows Explorer icon on the desktop and navigate to the following folder: 

C:\Program Files\Agilent\SignalAnalysis\Physics

6. Double-click on BackupAndRestore.exe. The "Calibration Data Backup And Restore" dialog shown in Figure 5-4 
appears.

Figure 5-4 Calibration Data Backup

7. In the group box “Specify Backup Folder or File Name” use the mouse to press the “...” button to open the “Browse 
For Folder” dialog.

8. In the "Browse For Folder" dialog, select or create the desired folder on the USB memory device, then press OK.

9. Press Backup, then wait for the calibration database to be backed up.

10. When the backup has completed, close the "Calibration Data Backup And Restore" dialog.

Data Restore using Utility Program
Follow the steps below:

1. Close the instrument application software by pressing File > Exit > Enter.

2. Plug the mouse’s USB cable into one of the instrument’s USB ports.

3. Plug the USB memory device into another of the instrument’s USB ports.

4. Using the mouse double-click on the Windows Explorer icon on the desktop and navigate to the following folder: 

C:\Program Files\Agilent\SignalAnalysis\Physics

5. Double-click on BackupAndRestore.exe: the "Calibration Data Backup And Restore" dialog shown in Figure 5-4 
appears.
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Figure 5-5 Calibration Data Backup

6. In the group box “Specify File To Restore From” use the mouse to press the “...” button to open the “Browse For File” 
dialog.

7. In the "Browse For File" dialog, select the desired file on the USB memory device, then press OK.

8. Press Restore, then wait for the calibration database to be restored.

9. When the restore has completed, close the "Calibration Data Backup And Restore" dialog.

Software Revision A.02.00 or Greater

For software revisions A.02.00 or greater, the SQL calibration data file is read and written by the Alignment Data Wizard.

Data Backup or Restore using Alignment Data Wizard
The Alignment Data Wizard is launched directly from the instrument application software interface, so you do not need to 
exit the application software before proceeding. 

Follow the steps below to start the wizard:

1. Plug the mouse’s USB cable into one of the instrument’s USB ports.

2. Plug the USB memory device into another of the instrument’s USB ports.

3. Plug the USB keyboard into another of the instrument’s USB ports.

4. Press System > Alignments > Backup or Restore Align Data...

5. When prompted, press OK to close the instrument application.

6. The Alignment Data Wizard dialog appears, as shown in Figure 5-6 below:



40 

Memory Clearing, Sanitization and Removal Procedures
Archiving and Restoring Factory Calibration Data Files

Figure 5-6 Alignment Data Wizard Dialog

7. Follow the wizard’s on-screen instructions to back up the calibration data to the external USB memory device, or 
restore the data from the device.
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6 Processor Assembly Removal Procedure

To remove the processor board assembly, follow the procedure below, while referring to Figure 6-1, which shows the rear 
panel of instruments with Single-Core, Fixed Disk processor assemblies. 

The procedure for instruments with Single-Core, Removable Disk or Dual-Core, Removable Disk processor assemblies is 
identical, although the appearance of the rear panel differs from that shown in Figure 6-1. (For comparative illustrations 
of the rear panel types, see “Rear Panel Configurations” on page 14.)

CAUTION Before removing the Processor Assembly, ensure that the instrument’s power is turned off.

Figure 6-1 Processor Assembly Removal Procedure
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1. Locate and remove the Processor Assembly from the instrument, by removing the 6 rear panel screws (part number 
0515-0372, M3 x 0.5, 8 mm long). 

2. The assembly can be removed from the chassis by pulling it straight out. Use the two ejector arms to remove the 
Assembly from the instrument

TIP Most Application License keys are stored in EEPROM on the A7 Midplane Assembly (as described 
in Item 3 of Table 4-1 on page 20). Therefore, when replacing the Processor Assembly, you do 
not need to back up and restore the license keys.

The sole exception is the license key for the 89601A VSA Application. For information about how 
to regenerate these licenses, see “Regenerating a Site Key License for 89601A VSA Application” 
on page 31.
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7 Disk Drive Removal Procedure

This chapter describes the procedures for physical removal of the disk drive from:

a. Instruments with Non-Removable Drives (generally, older MXA, EXA and CXA instruments),

b. Instruments with Removable Drives (generally, all PXA instruments, and newer MXA, EXA and CXA instruments).

For detailed information about the drive types installed in each instrument type, see the section “X-Series Processor and 
Disk Drive Configurations” on page 10, in the Chapter Products Covered by this Document.

TIP Most Application License keys are stored in EEPROM on the A7 Midplane Assembly (as described 
in Item 3 of Table 4-1 on page 20). Therefore, when replacing the Disk Drive, you do not need to 
back up and restore the license keys.

The sole exception is the license key for the 89601A VSA Application. For information about how 
to regenerate these licenses, see “Regenerating a Site Key License for 89601A VSA Application” 
on page 31.

When installing a replacement Disk Drive, ensure that the instrument software revision on the 
replacement drive matches that of the original drive.
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Instruments with Non-Removable Drives

To remove the disk drive, follow the procedure below, while referring to Figure 7-1. The numbered items in the figure 
correspond to the step numbers in the procedure.

Before commencing this procedure, remove the complete Processor Assembly from the instrument, following the 
procedure described in the chapter Processor Assembly Removal Procedure.

Figure 7-1 Disk Drive Removal Procedure

1. Remove 15 screws from the top lid of the Processor Assembly.

2. Tilt the lid up.

3. While holding the disk drive to prevent it from falling, remove the 4 drive retaining screws.

4. Disconnect the drive cable from the disk drive. 
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Instruments with Removable Drives

To remove the disk drive, follow the procedure below. You do not need to remove the Processor Assembly from the 
instrument before removing the drive.

The numbered items in the figures below correspond to the step numbers in the procedure.

CAUTION Before removing the disk drive, ensure that the instrument’s power is turned off.

1. Locate the Processor and Disk Drive Assembly on the instrument’s rear panel, as shown in Figure 2-2 in the section 
“Rear Panel Configurations” on page 14. In Figure 7-2 below, the processor assembly is shown removed from the rear 
panel for clarity.

Figure 7-2 Processor Assembly with Removable Disk Drive

2. Locate the removable drive, and its retaining thumbscrew, as shown in Figure 7-2.

3. Turn the thumbscrew to release the drive from the panel, as shown in Figure 7-3 below. If the thumbscrew is too tight 
to turn by hand, use a TORX T10 screwdriver to loosen it.
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Figure 7-3 Removable Disk Drive Unit partially extracted

4. Pull the U-shaped handle attached to the drive unit, to remove the drive from the Processor Assembly, as shown in 
Figure 7-3.
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8 User and Remote Interface Security Measures

This chapter discusses options that are available to you to control and configure remote access to the instrument, 
including:

• SCPI/GPIB Control of Interfaces

• Operating System Security Features

• USB Interfaces. This topic includes information about how to set the instrument’s USB ports to read-only.

IMPORTANT Users are responsible for providing security for the I/O ports for remote access, by controlling 
physical access to the I/O ports. The I/O ports must be controlled because they provide access 
to most user settings, user states, and the display memory.

SCPI/GPIB Control of Interfaces

The GPIB command LLO (local lockout) can be sent by the controller to disable operation of the instrument’s front-panel 
keys and softkey menus.

However, sending the LLO command does not disable access to the instrument via its USB ports. For details of how to 
restrict the operation of the USB ports, see “Configuring USB for Read-only” on page 51 below.

Operating System Security Features

The instrument’s Windows operating system includes a variety of features that you can invoke or modify to enhance 
system security. These include the following:

• The ability to create custom user accounts, and assign different security levels to each account by adding it to an 
existing group. The group types predefined by Windows are: Administrator, Power User, User, Backup Operator, and 
Guest, but you can also define new group types.

• To provide additional protection for instruments that have a network (or internet) connection, the standard Windows 
Firewall is enabled by default.

• You can install standard third-party antivirus and spyware detection software designed for use with Windows. If your 
instrument has a network (or internet) connection, this may be advisable.
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CAUTION Running any third-party program while making measurements may adversely affect the 
instrument’s performance.

Details of all these features are provided in the "Windows Security" chapter of the Keysight X-Series Signal Analyzer: 
Getting Started Guide.

Determining the Instrument’s Operating System

You can easily determine your instrument’s operating system version as follows:

1. Using the instrument front-panel, press System > Control Panel...

2. The Windows Control Panel appears. From the menu at the top of the Control Panel window, select Help > About 
Windows

3. The About Windows message box appears, displaying the installed version of Windows

USB Interfaces

The instrument’s Microsoft Windows operating system can be configured to improve the security of the USB interfaces. 
This section includes the following topics:

“Disabling or Enabling AutoRun/AutoPlay” on page 48

“Configuring USB for Read-only” on page 51

Disabling or Enabling AutoRun/AutoPlay

AutoRun, and the associated AutoPlay, are Windows features that assist users in selecting appropriate actions when new 
media and devices are detected. The AutoRun feature is disabled in the instrument by default, for improved security, 
unless the Administrator account is running. (In Administrator mode, AutoRun is enabled, to aid with program 
installation.)

The procedure for disabling and enabling AutoPlay depends on your instrument’s operating system (either Windows 7 or 
Windows XP). To determine the operating system version of your instrument, see “Determining the Instrument’s 
Operating System” on page 48.

Windows 7
If your instrument has the Windows 7 operating system, you can disable or enable AutoPlay via the Control Panel. Open 
the Control Panel and select Hard ware and Sound > AutoPlay, then uncheck or check the "Use AutoPlay for all media 
and devices" checkbox.

If you want to understand details of how this AutoPlay setting affects the Windows Registry, see the Windows XP 
discussion below.

Windows XP
You can change the AutoRun configuration by editing the value of one of two Windows Registry keys. The Windows 
Registry is a database that stores critical configuration information for the instrument’s operating system.

CAUTION Exercise extreme caution whenever you edit the Windows Registry. Entering an incorrect 
Registry value, or accidentally deleting Registry keys, may have serious consequences that can 
prevent the system from starting, or require that you reinstall Windows. The instructions in 
“Disable & Enable Procedure” on page 50 below assume that you are familiar with the use of the 
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Windows Registry Editor to modify Registry settings.

Registry Key Definitions
AutoRun can be configured per-machine or per-user.

NOTE If the per-machine Registry key is present, its settings override those of the per-user Registry 
key.

The Registry key that controls the per-machine AutoRun settings is:

HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer\NoDriveTypeAu
toRun

The Registry key that controls the per-user AutoRun settings is:

HKEY_CURRENT_USER\SOFTWARE\Microsoft\Windows\CurrentVersion\policies\Explorer\NoDriveTypeAut
oRun

In the following discussions, we use the industry-standard abbreviation HKLM for the root key HKEY_LOCAL_MACHINE, and 
the industry-standard abbreviation HKCU for the root key HKEY_CURRENT_USER.

The DWORD value of either of these entries represents a set of single-bit flags. Each flag specifies the AutoRun setting for 
a specific drive type, as shown in Figure 8-1. Setting a bit flag to 1 disables AutoRun for that drive type.

Figure 8-1 AutoRun Flag Definitions for NoDriveTypeAutoRun Registry entry
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As shown in Figure 8-1 above, the default Windows XP (post-SP2) and Windows 7 value for this entry is 0x91 (under the 
entry HKCU\...\NoDriveTypeAutoRun). This setting disables AutoRun for Unknown and Network drives, but enables 
AutoRun for Removable, Fixed, CD/DVD or RAM drives.

You can disable AutoRun for all drive types by changing the value to 0xFF, as described in the following section.

Disable & Enable Procedure
In view of the interaction between the per-machine and per-user Registry settings, as described above, it is 
recommended that, if both keys exist in your instrument’s Registry, you should alter the settings of both Registry keys to 
the same value at the same time.

Use the following procedure to disable AutoRun for all drive types, or to revert all AutoRun settings to their Windows XP 
or Windows 7 default values. (Note that if your instrument has a Windows 7 operating system, there is a simpler way to 
do this via the Control Panel; see “Windows 7” on page 48 above.)

1. Open the Windows Registry editor, using one of the following methods depending on your instrument’s operating 
system:

a. For Windows XP, select Run... from the Windows Start menu. Then, type regedit into the Windows Run dialog 
box, as shown in Figure 8-2 below, and click OK.

Figure 8-2 Windows XP Run Dialog

b. For Windows 7, click the Windows Start button at the bottom left of the screen, type regedit into the Search 
programs and files box, as shown in Figure 8-3 below, then press Enter.

Figure 8-3 Windows 7 Search edit box

2. The Registry Editor window appears. Using the tree view control on the left of the window, navigate to the 
per-machine (HKLM) key: HKLM\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer.

3. To disable AutoRun for all drive types, set the value of entry NoDriveTypeAutoRun to 0xff.

To revert AutoRun settings to the Windows default values, set the value of entry NoDriveTypeAutoRun to 
0x91.
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4. Again using the tree view control on the left of the Registry Editor window, navigate to the per-user (HKCU) key: 
HKCU\SOFTWARE\Microsoft\Windows\CurrentVersion\policies\Explorer.

5. To disable AutoRun for all drive types, set the value of entry NoDriveTypeAutoRun to 0xff.

To revert AutoRun settings to the Windows default values, set the value of entry NoDriveTypeAutoRun to 0x91.

6. From the Registry Editor menu, select File > Exit to save the settings and exit the editor.

7. Shut down and restart the instrument, to enable the new settings to take effect.

Microsoft AutoRun Patch

NOTE The information in this section applies only to Windows XP. If your instrument has a Windows 7 
operating system, you do not require this patch.

There is a defect in Windows XP that compromises the ability to disable AutoRun. This defect has been fixed by a patch 
from Microsoft, as described in the Microsoft Knowledge Base Article ID: 967715.

This patch has been included in new instrument shipments from the factory since revision A.03.00.

After the patch has been applied, there will be a Registry entry at:

HKLM\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer\HonorAutorunSetting with a 
default value of 1.

More Information
The following Wikipedia articles provide more information about AutoRun and AutoPlay:

http://en.wikipedia.org/wiki/AutoRun

http://en.wikipedia.org/wiki/AutoPlay

Configuring USB for Read-only

As from instrument software revision A.04.00, a convenient mechanism is provided to set the instrument’s USB interfaces 
to read-only, thus preventing transfer of files from the instrument onto USB devices.

You can change this setting only when you are logged on as the Administrator. For details of how to log on to the 
instrument as the Administrator, see the Keysight X-Series Signal Analyzer: Getting Started Guide. To change the setting, 
do the following:

1. If you are not currently logged on to the instrument as the Administrator, you must log off.

If you are currently logged on to the instrument as the Administrator, and the Keysight XSA application is already 
running, go to Step 4.

The log-off procedure executes more quickly if you first exit the Keysight XSA application, but you can also log off 
without exiting the application.

2. To log off, use one of the following procedures, depending on your instrument’s operating system:

a. For Windows XP, select Log Off from the Windows XP Start menu (as highlighted in Figure 8-4 below), then click 
Log Off in the Log Off Windows dialog that appears.

http://en.wikipedia.org/wiki/AutoRun
http://en.wikipedia.org/wiki/AutoPlay
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Figure 8-4 Log Off Button in Windows XP Start Menu

b. For Windows 7, click the Windows Start button, then select Shut down > Log off from the Windows Start menu, 
as shown in Figure 8-5 below.

Figure 8-5 Windows 7 Log off Control

3. After you have logged on to the instrument as the Administrator, restart the Keysight XSA application. 

4. When the XSA application has fully initialized (that is, when the main results view and softkey menu are visible), press 
the System front-panel key.

5. From the System softkey menu, select: More > Security > USB.

6. Select the option Read Only.

7. To activate the configuration change, either log out and then back in under your usual user name (which by default is 
"instrument"), or cycle the instrument power.
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9 Procedure for Declassifying a Faulty Instrument

Even if the instrument is not able to power on, it may be declassified by removing the disk drive from the instrument, using 
the appropriate procedure as described in “Disk Drive Removal Procedure” on page 43.
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10 Special Options

There are certain special options for X-Series instruments that provide security-related functionality. The following 
available options are described in this chapter.

• “Option SF1” on page 56

• “Option SF2” on page 57
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Option SF1

Option SF1 is a license key-enabled special option that addresses the requirements of security-conscious users. Installing 
Option SF1 in the instrument causes changes to available functionality in certain menus, and suppression of certain SCPI 
commands, to prevent the launching of Windows programs from the instrument application. This reduces the 
instrument’s vulnerability to the effects of unauthorized or undesirable third-party programs or scripts.

This section summarizes the functional modifications to the instrument capabilities when Option SF1 is installed.

Support

Option SF1 is supported on all X-Series instruments with software revision A.12.06 or greater.

Menu & Command Changes

Installing Option SF1 causes the following menu and command changes in the instrument.

File Menu

• In the File menu, the File Explorer... key is not available.

System Menu

• In the System menu, the keys Control Panel..., Licensing..., and Internet Explorer... are not available.

• In the System > Diagnostics menu, the keys Front Panel Test..., Ad vanced, FP State Logger, and Quick Test..., and 
the functions of all submenus of these keys, are not available.

• In the System > Service > Diagnostics menu, the Ad vanced key and all functions of its submenu are not available.

• In the System > Service > Align > Diagnostics menu, the Align Log... key is not available.

SCPI Commands

• The SCPI command :SERVice[:PRODuction]:RUN is not available.

Right-Click (Popup) Menu
When Option SF1 is installed, the Virtual Front Panel selection and functionality (under the Utility menu) are not 
available.
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Option SF2

Option SF2 is a license key-enabled special option that addresses the requirements of security-conscious users who need 
to be able to prevent the saving of measurement results or user configurations to the instrument’s disk drive. The option 
also prevents the recall of results and configurations from the disk.

Installing Option SF2 makes the following changes to the instrument’s operating environment:

• Modifies aspects of the Windows operating system, specifically to disable memory page file usage. For details, see 
“Operating System Changes” on page 57.

• Disables certain menu keys and SCPI commands, eliminating the ability to save or recall user data. For details, see 
“Menu & Command Changes” on page 58.

Support

Option SF2 is supported on all X-Series instruments with software revision A.14.00 or greater. This option requires the 
instrument to have the Windows 7 operating system. Instruments with the Windows XP operating system do not support 
Option SF2. (For more information, see “Determining the Instrument’s Operating System” on page 48.)

Operating System Changes

Installing Option SF2 disables Windows memory page files. The reason for this change is to ensure that memory page 
swapping does not inadvertently cause the instrument to create on-disk copies of RAM data.

Note that one effect of disabling memory page files is to reduce the available memory space for preloading applications 
at power-on.

TIP If a disk recovery and software update to revision A.14.00 and above is performed, memory 
paging files will automatically be re-enabled. If the X-Series application is then started (with 
Option SF2 installed), the message shown in Figure 10-1 appears, describing how to disable the 
page files.

The X-Series application will not start until memory page files are disabled. For details of how to 
run SF2RegSetup.reg, refer to Installation Note: Keysight X-Series Signal Analyzers Option 
SF2.

Figure 10-1 Option SF2 System Incompatibility Message
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Menu & Command Changes

Installing Option SF2 causes several menu and command changes in the instrument, as follows.

Front-panel Keys
The functions of the following front-panel keys are disabled. Pressing one of these keys displays the informational 
message “Settings conflict; Feature not available for Option SF2”.

• Print

• Quick Save

• Recall

• Save

NOTE Save and Recall are often used with the N9069A Noise Figure Measurement Application to allow 
multiple noise sources to be used without the need to re-enter ENR values or to perform the 
noise source calibration each time a different noise source is connected. When Option SF2 is 
installed, this functionality is not available.

File Menu

• The Page Setup... and Print... keys are not available.

System Menu

• In the System > Power On menu, the Power On Type selection keys (Mode Preset, User Preset and Last State) are 
not available.

SCPI Commands
The following SCPI commands are not available. Attempting to use these commands generates the Error message 
–113,”Undefined header".

Note that some of the commands listed are specific to individual applications, thus the set of available commands 
depends on which applications are licensed for a given instrument.

• *RCL

• *SAV

• :MMEMory:CLEar:ALL

• :MMEMory:CLEar:STATe

• :MMEMory:COMMent

• :MMEMory:COPY:DEVice

• :MMEMory:INITialize

• :MMEMory:LOAD:ALIMit

• :MMEMory:LOAD:ALISt

• :MMEMory:LOAD:ATRace

• :MMEMory:LOAD:AUTO

• :MMEMory:LOAD:CAPTured

• :MMEMory:LOAD:CHTable
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• :MMEMory:LOAD:CORRection

• :MMEMory:LOAD:ENR

• :MMEMory:LOAD:EVMSetup

• :MMEMory:LOAD:FREQuency

• :MMEMory:LOAD:LIMit

• :MMEMory:LOAD:LOSS

• :MMEMory:LOAD:MASK

• :MMEMory:LOAD:MPADapter:CORRection

• :MMEMory:LOAD:PSET

• :MMEMory:LOAD:REGister

• :MMEMory:LOAD:SCAN

• :MMEMory:LOAD:SETup

• :MMEMory:LOAD:SLISt

• :MMEMory:LOAD:SSSetup

• :MMEMory:LOAD:STATe

• :MMEMory:LOAD:STATe:VSA

• :MMEMory:LOAD:T2Config

• :MMEMory:LOAD:TMMConfig

• :MMEMory:LOAD:TRACe

• :MMEMory:LOAD:TRACe:DATA

• :MMEMory:LOAD:TRACe:REGister

• :MMEMory:LOAD:VSASetup

• :MMEMory:LOAD:ZMAP

• :MMEMory:MSIS

• :MMEMory:NAME

• :MMEMory:NFIGure:LOAD:ENR

• :MMEMory:NFIGure:LOAD:FREQuency

• :MMEMory:NFIGure:LOAD:LOSS

• :MMEMory:NFIGure:STORe:ENR

• :MMEMory:NFIGure:STORe:FREQuency

• :MMEMory:NFIGure:STORe:LOSS

• :MMEMory:REGister:STATe:LABel

• :MMEMory:RESults:CORRection:MODE

• :MMEMory:RESults:LIMits:MODE

• :MMEMory:RESults:OUTPut

• :MMEMory:RESults:SCAN

• :MMEMory:RESults:SCReen:THEMe

• :MMEMory:RESults:SLISt

• :MMEMory:RESults:TRACe:DATA

• :MMEMory:RESults:TRACe:HEADer



60 

Special Options
Option SF2

• :MMEMory:RESults:TRACe:SETTing

• :MMEMory:SELect[:ITEM]:ALL

• :MMEMory:SELect[:ITEM]:DEFault

• :MMEMory:SELect[:ITEM]:HWSettings

• :MMEMory:SELect[:ITEM]:LINes:ALL

• :MMEMory:SELect[:ITEM]:NONE

• :MMEMory:SELect[:ITEM]:SCData

• :MMEMory:SELect[:ITEM]:TRACe[:ACTive]

• :MMEMory:SELect[:ITEM]:TRANsducer:ALL

• :MMEMory:STORe:ALIMit

• :MMEMory:STORe:ALISt

• :MMEMory:STORe:ATRace

• :MMEMory:STORe:CAPTured

• :MMEMory:STORe:CHTable

• :MMEMory:STORe:CORRection

• :MMEMory:STORe:ENR

• :MMEMory:STORe:FREQuency

• :MMEMory:STORe:LIMit

• :MMEMory:STORe:LOSS

• :MMEMory:STORe:MPADapter:CORRection

• :MMEMory:STORe:PSET

• :MMEMory:STORe:RESults

• :MMEMory:STORe:RESults:MTABle

• :MMEMory:STORe:RESults:PTABle

• :MMEMory:STORe:RESults:SNGLS

• :MMEMory:STORe:RESults:SPECtrogram

• :MMEMory:STORe:SCAN

• :MMEMory:STORe:SCReen

• :MMEMory:STORe:SCReen:THEMe

• :MMEMory:STORe:SLISt

• :MMEMory:STORe:STATe

• :MMEMory:STORe:T2Config

• :MMEMory:STORe:TMMConfig

• :MMEMory:STORe:TRACe

• :MMEMory:STORe:TRACe:DATA

• :MMEMory:STORe:TRACe:REGister

• :MMEMory:STORe:ZMAP

• :MMEMory:TRACe:CLIent

• :MMEMory:TRACe:CLIent:STATe

• :MMEMory:TRACe:OPERator
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• :MMEMory:TRACe:OPERator:STATe

• :MMEMory:TRACe:PDEScription

• :MMEMory:TRACe:PDEScription:STATe

• :MMEMory:TRACe:TITLe

• :MMEMory:TRACe:TITLe:STATe

• :SYSTem:PON:TYPE

• :SYSTem:PRESet:SAVE

• :SYSTem:PRESet:TYPE

• :SYSTem:PRESet:USER

• :SYSTem:PRESet:USER:ALL

• :SYSTem:PRESet:USER:SAVE

• :SYSTem:PRINt:THEMe

Right-Click (Popup) Menu
When Option SF2 is installed, the following functionality is not available.

In the main menu:

• User Preset

Under the Utility submenu:

• Quick Save

• Save

• Recall
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A: References

1. DoD 5220.22-M, “National Industrial Security Program Operating Manual (NISPOM)”

United States Department of Defense. Revised February 28, 2006.

May be downloaded in Acrobat (PDF) format from:

http://www.dss.mil/isp/fac_clear/download_nispom.html

2. ISFO Process Manual for the Certification and Accred itation of Classified Systems under the NISPOM

Defense Security Service.

DSS-cleared industries may request a copy of this document via email, by following the instructions at: 

http://www.dss.mil/isp/odaa/request.html

3. Keysight X-Series Signal Analyzer: Getting Started Guide

Keysight Technologies 2008-2014. Part Number: subject to change as document is revised.

A printed copy of this document is supplied with each Keysight X-Series Analyzer. 

It is also available in Acrobat (PDF) form: 

• on the Documentation DVD supplied with each instrument,

• on the instrument’s disk drive at the following location:

C:\Program Files\Agilent\SignalAnalysis\Infrastructure\Help\bookfiles\getstart.pdf

• via download from:

www.keysight.com/find/xseries_getting_started_guide

4. Microsoft Knowledge Base Article ID: 967715

"How to disable the AutoRun functionality in Windows": may be viewed at:

http://support.microsoft.com/kb/967715

Note that a second article, at: http://support.microsoft.com/kb/953252, "How to correct ’disable AutoRun registry key’ enforcement 
in Windows", redirects to article ID 967715.

5. Installation Note: Keysight X-Series Signal Analyzers Option SF2

Keysight Technologies 2014. Part Number: N9020-90234.

May be downloaded from:

http://literature.cdn.keysight.com/litweb/pdf/N9020-90234.pdf

http://www.dss.mil/isp/fac_clear/download_nispom.html
http://www.dss.mil/isp/odaa/request.html
http://literature.cdn.keysight.com/litweb/pdf/N9020-90234.pdf
http://support.microsoft.com/kb/967715
http://support.microsoft.com/kb/953252
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